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Introduction

Thank you for purchasing the JLCooper CS-1 Control Station.
This CS-1 is an ADB (Apple Desktop Bus) device, designed for
use with Macintosh computers. You connect it just like a
mouse or keyboard.

The CS-1 allows you to create a personalized control station for
virtually any Macintosh application. You will find that the
CS-1's smooth, optically encoded jog wheel and transport keys

make creative multi-media production and editing easier than
ever.

The CS-1 wheel can play back movies, jog through sound files,
scroll through event lists, and more. And the CS-1 keys can
send command-key equivalents and mouse clicks.

This allows you to use your CS-1 to bring the most frequently
used menu items and commands speedily within reach,
providing more comfortable and creative control of your
favorite applications.

The CS-1 allows you to create an unlimited number of
“Keysets”. You can have a different “Keyset” for each
Macintosh application.

The CS-1 detects which application is active, and the behavior
of the CS-1 changes accordingly as you change applications.

The included CS-1 application software and extension
are required for the CS-1 hardware to operate.

Please take a moment to send in your product registration card,
so we can notify you in the future about any new products or
updates as they become available.



Connecting the CS-1

First locate an ADB port on the back of your Macintosh.
It is identified by the ADB icon.

Your Macintosh computer may have one or two of these ports.

If the Mac has two ports, it does not matter which one you use.
Connect an ADB cable from the Mac to either of the CS-1's
ports.

If the Mac has a single ADB port, do the following.
Unplug the keyboard cable that is connected there now.
Connect an ADB cable from the Mac to either of the CS-1's
ports.

Then plug your keyboard cable into the CS-1's remaining ADB
port.

An optional, user-supplied footswitch may be plugged into the
foot switch jack on the back of the CS-1 The switch should be a
momentary type, though it does not matter whether it is
"normally open" or "normally closed".

The CS-1 can automatically sense whether the switch is a
normally open of normally closed type. So virtually any
momentary contact switch will work. If using a footswitch,
Dplug it in before the power is turned on so that the CS-1 can
"read" the switch to determine what type it is.

(Some CS-1 units also have a 5 pin din jack labeled "AUX"
which bas no function.)



Installing the Software

The CS-1 disk contains at least three items:
The CS-1 Application, the CS-1 Extension, and a Keysets folder.

There may also be "Read Me" files containing late-breaking
information not found in this manual.

This disk is not copy protected, we encourage you to make a
back-up copy and keep the original in a safe place.

Install the application simply by drag-copying it onto your
hard drive.

Install the extension by dragging it into the closed System
Folder. A Macintosh system dialogue will appear asking you to
confirm that you want the extension to be placed in the
Extensions folder. Press Enter or click OK.

Enable the extension using the Control Panel “Extensions
Manager” (or Startup Manager or equivalent).

Restart the Macintosh and observe the icon during boot up.

The extension will load only if the CS-1 is already connected to
the Macintosh on boot up.

If the CS-1 is not connected, there will be an X over the icon.

If you have difficulty getting the extension to load, please refer
to the section entitled “Troubleshooting” toward the end of this
manual.

The Keysets folder contains optional files for the CS-1 that
may be helpful if you are working with any of the applications
named within the folder. Copy this folder onto your hard drive.
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Getting Started

First of all, remember that the CS-1 Extension is required for the
CS-1 to operate.

The CS-1 will not appear to send any commands into the
Macintosh unless the Extension has been properly loaded
upon start up.

The reason for this is that the CS-1, unlike a mouse or
keyboard, sends special "invisible" ADB codes into the
Macintosh. And it is the Extension that is responsible for
"re-mapping" these commands into useful ADB commands,
such as key presses and pointer movement.

When the Macintosh boots up, the CS-1 ONLINE LED turns on.
This shows that the CS-1 is getting power from the Mac.

The application is launched by double-clicking on the CS-1
icon.

If the extension did not load, the CS-1 application will run but
no changes will be saved.



What Does the CS-1 Do?

When you press a key or turn the wheel, the CS-1 behaves like
a Macintosh keyboard or mouse.

The CS-1 gives you the ease and convenience of using a
conventional tape recorder style transport control, which will
improve the speed you are able to work .

The CS-1 also provides a way of remotely controlling your
computer when seated at a location other than directly in front
of the monitor.

Key Press Emulation

The CS-1 can send a variety of commands, including simple

keystrokes, like the letters “a”, “j”, symbols such as “@”, and
function keys such as “F1”.

The CS-1 can also send keys with modifiers. Pressing a single
CS-1 key can send the equivalent of a cluster of keys, for
example, Control-Option-Shift A.

The simplest example is this: Many applications will play back
previously recorded music and or movies when you press the
Macintosh keyboard’s spacebar. So, you might want the CS-1
Play key to imitate a spacebar. When you press the CS-1 Play
key, the Macintosh “thinks” that you have pressed the

spacebar, and the software begins to play back music and or
movies.

Mouse Emulation
The CS-1 keys also send mouse clicks. Pressing the CS-1 key

can produce a mouse click at specific, user-selected location
within a window.

Most software applications have some on-screen buttons or
icons for which there is no key-equivalent at all. Again, the

CS-1 gives you single-key access to those buttons and icons.
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The Wheel

The wheel sends repeated key characters, (such as arrow keys
for playing QuickTime™ movies).

The wheel is also capable of performing horizontal and vertical
mouse moves and drags.

The rate of pointer movement or repeated key presses is set by
a Speed Slider, which allows the user to personally customize
the wheel response.

Certain applications allow even more control from the CS-1
wheel, including features such as video or audio jog or shuttle.



What is a Keyset?
The CS-1 has five keys called “Transport” keys.

They're called transport keys only because they are labeled
with the standard “tape recorder” transport icons for rewind,
fast forward, stop, play, and record.

These keys are user-definable. You can program the CS-1 so

that these keys control many things in addition to transport-
related functions.

The CS-1 also has four F (function) keys, four diamond keys,
and a footswitch, for a total of 14 controls.

Each key can send a different Macintosh ADB command.
In addition there is a Shift key.

Since you can activate any of these controls alone, or with the
Shift key, that means that CS-1 can send 28 different
commands.

The wheel has its own dedicated button and LED. This is
labeled ONLINE (don't ask why). The LED can be on or off.
The wheel can send two different kinds of commands
depending on whether the LED is on or off.

The 28 key commands plus the 2 wheel commands are
collectively called a “Keyset”.

10



Keyset Selection
One Keyset may be created for each application.

The CS-1 automatically senses which application is running,
and selects the appropriate Keyset.

For example, the CS-1 is able to send 28 commands from the
keys and 2 commands from the wheel.

Suppose you click on a window in the background, and make
a different application active.

This immediately “re-configures” the CS-1 with a completely
different Keyset, with 28 different commands and 2 different
wheel assignments.

When you return to the previous application, its associated
Keyset is instantly and automatically restored.

For example, suppose that one application plays a movie when
you press the spacebar, And a different application plays a
song when you press the return key.

You can set up the CS-1 so that the CS-1 Play key will always
cause the movie or the song to play.

The CS-1 will keep track of which application is active, and
"know" whether pressing the CS-1 Play key should send a
spacebar or a return key.

Iry it Now

Launch the CS-1 application.
Select "About CS-1".

Rotating the wheel causes the "movie" to go forward and also
makes the picture of the wheel slowly rotate.

The transport keys on the CS-1 make the movie rewind, stop,
play, and go fast forward.
11



About The Default Keyset

The first time you use the CS-1, the so-called "Default Keyset" is
automatically selected.

The Default Keyset is ready to use and should have some
functionality with QuickTime-related applications.

The wheel sends left and right arrow keys, to playback
QuickTime movies one frame at a time.

Play and Stop keys send a space and return, respectively.
These keys play and stop QuickTime movies.

The remaining keys have no assignment. They will not send

any keyboard commands or mouse clicks unless you edit the
Default Keyset.

Any time you open an application, if you haven’t yet created a
Keyset for that specific application, the Default Keyset will be
automatically selected.

12



Editing tbe Default Keyset

You can edit (that is, change) the Default Keyset at any time,
using the CS-1 application. Here are two simple examples of
how to edit the default Keyset:

Example of Changing What the Wheel Does
Presently, the wheel sends left and right arrow keys at a
medium speed.

Turning the wheel will play a movie in a2 QuickTime™ related
application, such as Movie Player.

Suppose you are editing a movie, and you want to use the
wheel to easily view the movie frame by frame. You may want
to slow down the response of the wheel, to make it easier to
find a specific frame.

We will use the Wheel Speed slider.

First, select the Wheel. Rotate the wheel a little in either

direction. Alternately, you may click on the picture of the
wheel.

Key Press
ag Qe oONDAs | -

Mouse Emulation:

l None v |

Yheel Speed:

The Wheel Speed slider setting affects the wheel for both
directions of rotation. For the purposes of this example, it
doesn't matter whether you select clockwise or counter-
clockwise rotation.

13



Current Keyset : “Default" eel LED O ckwis

Key Press:

osoooNoA [ |

Mouse Emulation:

| Hone

Wheel Speed:

Click on the Wheel Speed slider and drag it to the left.

Now the next time you switch to a QuickTime™ related
application, the wheel will make the movie play back more
slowly, allowing finer control.

The wheel will still produce the equivalent of typing arrow
keys, but with a slower key press repeat rate.

Example of Changing What a Key Does

Presently, in the Default Keyset, pressing the Record key does
nothing. Suppose that you want the Record key to send the
equivalent of the Mac's Enter key.

Press the CS-1 Record key to select it. Notice that the "Control
Info box" shows which key you've selected, Record, and the
Key Press that the Record key will emulate: None.

Tab to select the Key Press field. On the Macintosh keyboard,
press Enter. Now the CS-1 Record key will send Enter.

Name: IRecord

Key Press:
0¥ 00 0ONDA

Mouse Emulation:

[ fone _ ~]



Restoring the Default Keyset Using Clear
To restore the default Keyset back to its original generic
QuickTime™ settings, select Clear from the Edit menu.

The wheel will send left and right arrow keys again, to
playback QuickTime movies one frame at a time.

Play and Stop keys make the CS-1 send space and return,
which are used to play and stop QuickTime™ movies.

The remaining keys have no assignment. They will not send
any keyboard commands or mouse clicks.
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The CS-1 Application

The CS-1 application features a picture of the CS-1.
To the right is the “Control Info Box”, which displays what
each CS-1 control will do within a specific application.

Generally speaking, to edit (change) a CS-1 Key, you first select
the key by pressing it. (Or, you may use the mouse to click on
the picture of the key).

The control's name and function is displayed in the Control
Info Box, where they can be edited.

Key Press:

0% 06 ONOA
Mouse Emulation:

The "Stop” key is selected When "Stop” is pressed on the CS-1, it will emulate
the Macintosh's "Return” key.

Clicking on | opens a small, editable text window.

You may use this window to verify the key commands that are
coming from the CS-1.

You can also verify that the CS-1 is operating by opening the
About box in the Apple menu.

Clicking on [}

The intriguing, cryptic little icons under the words, "Key Press"
represent the standard modifier keys:

Command Shift Option Control
16 0% 04 00O~



Creating a New Keyset

Remember that a Keyset is the collection of commands that the
CS-1 can send, including 28 different key combinations and 2
different wheel modes. Each application can have its own
Keyset. The CS-1 senses which application is active, so it
knows which Keyset applies.

When you are ready to start programming the CS-1, you begin
by selecting New Keyset from the File menu. This "links" the
operation of the CS-1 with the application you want to control.

Select New Keyset from the File menu.

This opens a Select dialogue. Select the application that you
wish use with the new Keyset.

€3 applications ¥ < HD

Select the application which
will use this Keyset

The currently active Keyset name is displayed in the upper
right part of the CS-1 window.

Current Keyset : "movie editor”

17



Launch the Target Application
We will refer to the application that you wish to control as the
target application, to distinguish it from the CS-1 application.

Launch the target application that you desire to control, if it is
not already open.

You use the CS-1 application to edit Keysets, to make the CS-1
do what you want to do to the target application.

While you are editing and fine tuning your Keysets, you may
switch back and forth between the CS-1 application and the
target application.

Then, quit the CS-1 application, since it is not needed to use
the CS-1. Any time in the future that you open a target
application, the CS-1 will be ready to control that application.

Once you have created your Keysets, you do not need to open
the CS-1 application again to use the CS-1.

Remember also that if you open an application for which no
Keyset exists, the CS-1 will use the Default Keyset.

The only times that you ever need to open the
CS-1 application are when you wish to
create a New Keyset, delete a Keyset, Import, Export
or edit an existing Keyset.

Once you have created the desired Keysets, ordinary daily use
of the CS-1 does not necessitate launching the CS-1 application.

18



Assigning the Keys
Select a key by pressing the key.
Look at the Control Info box.

The permanent name of the CS-1 key is displayed first.
Under this, the Name field is highlighted.

You may give the key a name which is more descriptive of the
key's actual function.

Play

Mame : |Play Movie from beginning

Then Tab or click to select the "Key Press" field.

The Key Press field sets the character to be sent.
(The Mouse Emulation pop up menu sets mouse clicks.)

Decide if you want the key to send a character, or a mouse
click, or both.

To Make a Key Send a Character

Simply type the character on the Macintosh keyboard, with or
without modifier keys. Notice that the character and modifiers
appear in the CS-1 application's Key Press field.

If you do not want the key to send any character, press the
Macintosh keyboard's delete key.

If you want the key to send only a character, and not emulate a
mouse click, make sure that None is selected in the Mouse
Emulation pop up menu.

Understand that this process allows a single key on the CS-1 to
send a character with a "cluster" of modifiers.
Play,

For example, pressing Play only on the | " ,

Key Press:

CS-1 can send the equivalent of B% B0 BNEA

Mouse Emulation:

Command-Shift-Control-Option "p". [Ciowe =




To Make the Key Send a Mouse Click
If you chose to assign a key to send a mouse click, the click
can take place in a specific location within a window.

Alternately, the click can be unspecific, that is, the click can
occur wherever the pointer happens to be located.

You can also make a key send a click-lock, that is, a mouse
button down without a mouse button up. The mouse button
up occurs when the key is pressed a second time.

To Make a Key to Send a Simple Mouse Click:
From the Mouse Emulation pop up menu, select Click.

The click will occur within the target application, anywhere the
pointer is located.

Blay,
Name: | l
Key Press:
DR OO0 ONDA [d
Mouse Emulation:
I Click hd l

D Capture coordinates when
Play is first pressed

To Make a Key Send a Mouse Click Lock:
Select Click Lock from the Mouse Emulation pop up.
The mouse-down will occur at the location of the pointer.

The mouse will not un-click until one of the following events
occurs: The same key is pressed again, another key assigned to
a click or click lock is pressed, or the mouse itself is clicked.

Play,
Hame: [ I
Key Press:
08040 0NO0A~
Mouse Emulation:
|_Click Lock v |

[ capture coordinates when
Play is first pressed
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To Make a CS-1 Key Send a Click at a Specific Point:
This is the method that you use when you want a CS-1 key to
click on a button or icon within a window.

From the Mouse Emulation menu, select either Click or Click
Lock. Click will be used for most applications.

Then check the box, “Capture Coordinates...”.

Now, switch to the target application. You will use your mouse
briefly to specify the place where you want the click to occur.

Use the mouse to position the pointer over the location where
you want the click to occur.

Now, very important, you capture the mouse pointer
coordinates by pressing the desired CS-1 key.
(Not by clicking with the mouse!)

Now the next time that you press that key on the CS-1, while
you are in the target application, a click will occur at the
desired coordinates, without having to use the mouse.

Example
Suppose you have an application which features a window
with transport buttons. And suppose that these transport

buttons have no key equivalents; the only way to activate them
is to click on them.
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First you need to create a New Keyset. Select New Keyset from
the file menu. Then select the application that you want to
control. The name of the application will be displayed as the
"Current Keyset:" in the CS-1 application.

We will refer to this application that you are controlling as the
"target application", to distinguish it from the CS-1 application.

We will program the CS-1 Play key so that pressing the CS-1
Play key will result in a click on the target application's Play
button.

Select the Play key by pressing the Play key on the CS-1.

For this example, the key should send a mouse click only, and
no characters. Press the delete key on the Macintosh keyboard
to delete any characters from the Key Press field.

Select Click from the Mouse Emulation pop up menu.
Check "Capture Coordinates".

Elay,

Name: L l

Key Press:

0% 00 ONDA
Mouse Emulation:

| Click hd I

Capture coordinates when
Play is first pressed

Then switch to the target application. Move the mouse to
position the pointer over the Play button.

On the CS-1, press the Play key. This results in a click on the
Play button, the CS-1 Play key acting as a mouse button.

At the same time, the CS-1 "captures" the pointer's coordinates
The next time you press Play, the click automatically occurs at

the desired coordinates, without having to move the mouse.
22



The Keys and Hide Pointer

When you have assigned a key to produce a click, you will see
the pointer momentarily move to the location where the click
occurs. Then the pointer quickly returns to its original location.

If you do not want to see the pointer move, check “Hide
Pointer" from the Keysets menu.

Then the mouse click will occur “invisibly”. This is a very nice
effect because it makes it appear the CS-1 was designed as a
hardware control surface especially for your application.

If a click does not do what you expected, uncheck Hide

Pointer so you can observe where the click is actually
occurring.

For each Keyset, you can choose to check or not to check Hide
Pointer in the Keysets menu.

23



About Captured Coordinates

When a click has been captured, the coordinates of the click

and the name of the window in which the click occurred are
shown in the CS-1 application.

Play,

Key Press:

0% 00 ONOA

Mouse Emulation:

[ ctiek in * wransport *
at386,6

If the window does not have a name, then no name will
appear between the quotes.

Record

Name: [Ee

Key Press:

0800 ONDA

Mouse Emulation:

gk ~]
X click in *
at 189, 12
Re-Capturing Coordinates

You may want to "re-capture" the coordinates. For example,
you may not have had the mouse positioned correctly the first
time that you pressed the CS-1 key.

In that case, simply uncheck the check box. It will revert to its
original "Capture Coordinates of [name of controll...". Then
check it again. This "re-arms" the CS-1 to capture fresh
coordinates the next time you switch to the target application.
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Shift Key
The CS-1 Shift key allows you to make the CS-1 send up to 28
different key commands from the 13 keys and footswitch.

For example, to assign the command that the CS-1 will send
when Shift and Play are pressed together, first select Shift Play
by pressing Shift and Play at the same time. |
Alternately, you may click on Shift and Play in the CS-1
application.

Then assign the commands as described previously.
Type a Key Press, or select a Mouse Emulation menu item.

The Shift key on the CS-1 is not the same as the Macintosh's
Shift key.

The Macintosh Shift key always behaves like Shift.

The CS-1 Shift key does not limit you by sending the equivalent
of the Mac's Shift key.

For example, the CS-1 Play key by itself can send the
equivalent of Shift N.

But pressing Shift Play on the CS-1 can send the equivalent of
simply typing N without a modifier. Its up to you what the CS-1
Shift key will do.

25



About the Foot Switch
The 1/4" jack on the rear of the CS-1 accommodates an
optional, user-supplied foot switch.

The switch type is typically a momentary, spring loaded foot
switch. The technical designation is "SPST", that is, single pole
single throw, terminating in a standard 1/4" phone plug.

Switches may also designated as "normally open" and
"normally closed". The CS-1 can accommodate either of these
kinds of switches. The internal microprocessor inside the CS-1
automatically detects which kind of switch you have
connected, and configures itself accordingly.

The detection is made once during power up, so, if you plan
on using a foot switch, see to it that you have connected it to

the CS-1 before starting up the Mac.

Otherwise, be sure to re-start the Mac after connecting the foot
switch.

26



Assigning the Foot Switch

The foot switch is assigned just like the keys. It can send either
Mac key presses, or it can send a click. The click can occur at
specific, user-defined coordinates.

The CS-1 software makes the switch an "alternate action"
switch. This powerful feature allows the foot switch to send
two different commands. You can assign the foot switch to
send one kind of command, then send an alternate command
the second time you press the switch. This allows you to use
the foot switch for "play" and "stop", alternately.

Example

Suppose your application uses the Spacebar to initiate play.
And it responds to the Return key to stop.

Select Footswitch A.
Footswitch A
. Name: [Footswitch A
Tab to the Key Press field. Key Press:
Or, click on the Key Press field. ""“‘::" "3:-""
Press the spacebar. ™ 2|

Select Footswitch B.

Tab to the Key Press field.

Or, click on the Key Press Key Press:
i 0% 00 ONgA
field. Press the Return key. Mouse Emulation: =
[(Rone —  ~]

Now the Footswitch will alternately send a space and return.
27



Assigning the Wheel

The CS-1 wheel sends key presses, mouse emulation, or both.

The wheel is assigned by first selecting the wheel by rotating it
a little clockwise or counterclockwise. Alternately, the wheel
may be selected by clicking on the picture of the wheel.

Select the right side of the wheel for programming what the
wheel will send when rotated clockwise.

Select the left side of the wheel for programming what the
wheel will send when rotated counter-clockwise.

Look at the Control Info box. The state of the LED and wheel
direction is displayed first. Under this, the Name field is
highlighted.

You may give the wheel a name which is descriptive of its
function. Then Tab to select the "Key Press" field.

The Key Press field sets the character to be sent.
(The Mouse Emulation pop up menu sets mouse clicks.)

Decide if you want the wheel to send a character, or a mouse
click, or both.

To Make the Wheel Send Repeated Characters

The wheel will repeatedly send the same character over and
over again as you rotate the wheel. It can send a different
character for clockwise and counter clockwise rotation.

Type the desired character on the Macintosh keyboard, with or
without modifier keys (Command, Option, Shift or Control).
Notice that the character and modifiers appear in the CS-1
application's Key Press field.

Press the Mac's Delete key if you do not want wheel rotation to
send any keystrokes.

If you want the wheel to only send characters, and not emulate
a mouse, make sure that None is selected in the Mouse
Emulation pop up menu.



To Make the Wheel Emulate a Mouse
The wheel emulates a mouse by moving the pointer either
horizontal or vertical.

There are three possible ways that the wheel relates to the
mouse button, called Move, Drag, and Scroll.

Move
The pointer moves without any click.

Drag

Rotating the wheel automatically causes a click as if the mouse
button were being held mouse down. If the pointer is
positioned over a movable object, such as a window or icon,
then rotating the wheel will drag the object. The mouse click is

automatically released shortly after the user stops turning the
wheel.

Scroll

This is a pointer move that begins with a mouse-down, just like
a drag.

Only in this case, the mouse does not automatically "unclick"
(mouse-up) after the user stops turning the wheel.

Rather, the mouse-up occurs when the wheel is rotated back to
its original starting point, where the mouse-down first
occurred.

The mouse-up also occurs when any transport key is pressed.

This is useful for playing back audio and video in applications
that feature a small scroll bar for playback. The user can initiate
forward or backward playback by turning the wheel a little and
then taking their hands off the wheel, without having to
continuously rotate the wheel.

29



Wheel Drag from Specific Coordinates
This is the method that you use when you want the CS-1 wheel

to perform a drag or scroll from specific coordinates within a
window.

From the Mouse Emulation menu, select either Horizontal
Drag, Vertical Drag, Horizontal Scroll or Vertical Scroll.

Then check the box, “Capture Mouse Coordinates”.
Now, switch to the target application. You will use your mouse
briefly to simply specify the coordinates where you want the

click (mouse down) to occur.

Use the mouse to position the pointer over the area that you
want the click to occur.

Now, very important, you capture the mouse coordinates by
turning the wheel. (Not by dragging with the mouse!)

Now the next time that you turn the wheel on the CS-1, while

you are in the target application, a drag will occur starting at
the previously captured coordinates.
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The Wheel and Hide Pointer

While dragging or scrolling, the pointer moves to the location
where the click occurs. Then the pointer quickly returns to its
original location.

If you do not want to see the pointer move, check “Hide
Pointer" from the Keysets menu.

Then the pointer will drag “invisibly”.

For each Keyset, you can choose to check or not to check Hide
Pointer.
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Wheel Speed

The rate of keystrokes or mouse movement is set by the
Wheel Speed slider.

Yheel Speed:

This slider allows you to tune the responsiveness of the wheel.
For example, choose a faster speed for faster playback.
Choose a slower speed for finer control.

Wheel LED On and Wheel LED Off
The CS-1 ONLINE button and LED is simply an "alternate"
switch for the wheel.

It allows you to have two completely different wheel
assignments within a single Keyset.

You can assign the wheel to send one kind of command when
the LED is on, and a different command when the LED is off.

The CS-1 always powers-up in with the LED on.

Press the "ONLINE" button either the CS-1, (or click to select it
in the application), to toggle the state of the LED.

Within the CS-1 application, to assign what commands the
wheel will send when the Wheel LED is on, see to it that the
LED is on before assigning the wheel.

To assign an alternate command to the wheel, click on the
ONLINE button within the application or press the ONLINE
button on the CS-1 to turn the LED off

This allows you to assign what the CS-1 wheel will send when
its LED is off.
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Alert During Clicks, Drags and Scrolls

When Capture Coordinates is checked, CS-1 remembers the
pointer coordinates when you first pressed the transport key or
turned the wheel within the target application. A mouse click is
occurs, and the CS-1 remembers the name of the window in
which the click occurred.

So the next time you press a transport key or turn the wheel,
the CS-1 will "look for" the name of the window in which the
pointer coordinates were first captured, and produce a click.

It is possible that no windows are currently open.
If you press a transport key or turn the wheel and no windows
are open, you will see this alert.

No windows are open. This click will be
ignored!

Click OK (or press return or enter) to make the alert go away.

It is also possible that the window name has been changed.

If you press a transport key or turn the wheel and the name of
the window has been changed since the click was first
captured, you will see a message like this.

The window which was supposed to receive
this click, © Untitled1 ” is not open. If this

happens in the future, do you want the click
to occur in the window “my new project”?

(Cancet) {_ox ]

The original window name and the new window name are
shown. Click Cancel to cancel the click. Click OK if you want
to replace the window name with the new window name.
The click, drag, or scroll will occur in the new window.
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Special Wheel Modes

The so called “Special Wheel Modes” are reserved for software
developers.

When the wheel is assigned to send a “Special” command, it
sends an invisible ADB code. The wheel will most likely
appear do nothing.

Some applications have been developed for enhanced CS-1
support. The Special modes have been used by some

developers to implement features such as Audio and Video
Jog and Shuttle.

Some applications come with a CS-1 Keyset which makes use
of these Special modes. For specific information, refer to the
documentation of the software that you are controlling if it
includes a CS-1 Keyset.
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Additional Time Saving Hints

When capturing mouse clicks, it is not necessary to continually
switch back and forth between the CS-1 application and the
target application you intend to control.

You can "pre-arm" the CS-1 application to capture the pointer
coordinates for the wheel and all the keys.

Example

Suppose that you wish to create a Keyset that makes each
transport key click on a transport button within the window of
the target application. First, select New Keyset from the file
menu. Open the target application.

We will first delete the two "Default" key presses.
On the CS-1, press Stop to select the Stop key.
On the Mac, press Delete.

On the CS-1, press Play to select the Play key.
On the Mac, press Delete.

Next, arm each transport to capture coordinates.
From the Mouse Emulation menu, select Click.
Check "Capture Mouse Coordinates".

Repeat this process for the Fast Forward, Stop, Play, and
Record keys.

Then, switch to the target application. Use the mouse to point
to the "rewind" button within the target application.

On the CS-1, press the Rewind key.
This captures the mouse coordinates for the rewind button.

Move the mouse to the next on-screen button within the target
application, fast forward.

On the CS-1, press the fast forward key. This captures the
mouse coordinates for the fast forward button.
Repeat the process for each of the remaining keys. 35



About Delete and Tab
When the Key Press field is highlighted, pressing the Mac's
Delete key will clear any key press and insert the word "none".

No character is sent when the key is pressed or wheel is turned.

If you want a control to actually send the equivalent of the
Mac's Delete key, do the following.

Press Delete with a modifier key. For example, Option-Delete.
The Key Press field will show that Option-Delete was pressed.
Key Press:

0% 04 B8N0~

Then use the mouse to click and de-select the Option button.
This will leave the Delete intact. Now the CS-1 can send the
equivalent of the Mac's Delete key.

Key Press:

03% 04 l"'\: Qa

When the Mac's Tab key is pressed, you can select whether a
control's Key Press or Name field is highlighted.

If you want a control to actually send the equivalent of the
Mac's Tab key, do the following.

Press Tab with a modifier key. For example, Option-Tab.
The Key Press field will show that Option-Tab was pressed.
Key Press:

O 04 @0~

Then use the mouse to click and de-select the Option button.
This will leave the Tab intact. Now the CS-1 key send the
equivalent of the Mac's Tab key.

Key Press:
0¥ 04 Q"’C m R
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Display Keyset

When Display Keyset is selected, a second window opens.

This window displays the current assignments of each control
in the Keyset.

The name of the controls are displayed, in addition to the
control's Key Press or Mouse Click assignments.

The keys are shown along with their Shifted alternate
assignments, if any.

The wheel assignments are shown for both wheel modes,
ONLINE LED on and LED off.

To make the window go away, click the Close box.

tswitch

return
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Saving and Deleting Keysets

The CS-1 Keysets are automatically saved within CS-1’s
Preference file, called "CS-1 Prefs". You never have do a "Save"
when using the CS-1 application.

To delete a Keyset, select the Keyset from the Keyset menu.
Then select Delete from the Edit menu.

Importing and Exporting Keysets
Keysets, though automatically stored invisibly within the
Preferences file, may also be Exported or Imported.

This allows you to easily move Keysets from one location to
another, such as another computer. It also allows third-party
Keysets to be developed and added at any time.

To Import a Keyset, select Import Keyset from the File menu.
A standard Open dialogue lets you select the Keyset. Once
imported, the Keyset will appear in the Keysets menu.

The Keyset will also automatically be saved in the Preferences
file.

To Export a Keyset, select Export Keyset from the File menu.

A standard save dialogue will appear, to allow you to choose
where to put the exported Keyset. The Keyset retains the name
of the application that it is linked to.
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Using Supplied Keysets

Some Keysets for selected applications are included on the
CS-1 disk.

To use any of these Keysets, select Import from the File menu.
Then select the Keyset within the Import dialogue.

The Keyset will then be automatically saved in the
Preferences file, and will appear in the Keysets menu.
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CS-1 Application's Menus

File Menu
New Keyset...

Creates a New Keyset, and links it with a particular Target
Application.

In other words, when you are ready to start defining the
function of the CS-1, the first thing you do is select New
Keyset.

You will see a standard dialogue. Then select the application
that you wish to control with the CS-1. We refer to that
application as the "target" application, simply to distinguish it
from the CS-1 application.

Then you use the CS-1 application to assign what each control
will send. These assignments are collectively called a Keyset.

Import Keyset...

Imports a previously exported Keyset file.

Places the Keyset into the Keysets menu, and

saves the Keyset within the CS-1 application's Preference file.

Export Keyset...
Exports a Keyset as an independent file, to allow you to more
easily transfer the file to another computer.

Quit
Exits the CS-1 Application. Once you have defined your

Keysets, the CS-1 Application does not need to be running for
the CS-1 hardware to operate.
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Edit Menu
Undo
Undoes last operation.

Cut
Copies the currently selected text the Clipboard. Clears text.

Copy
Copies the currently selected text to the Clipboard.

Paste
Pastes the previously copied text.

Clear
Clears the selected text.

Copy Keyset
Copies the currently selected Keyset to the Clipboard.

Paste Keyset
Pastes the previously copied Keyset into the current Keyset.

Clear Keyset

Clears the Keyset, resetting the individual controls to their
Default settings.

Keysets Menu
This menu contains a list of all the Keysets that you have
created or imported.

It will always at least contain the Default Keyset.

Use this menu to select a Keyset to display the control
assignments and edit them.

Hide Pointer
For each Keyset, when checked, hides pointer during clicks.

Display Keyset
Opens window which displays all the names and control
assignments in the Keyset.



Technical Information
Troubleshooting

If for some reason the CS-1 does not give you the expected
results, take 2 moment to do some investigating.

The most important concept is that the extension is required
for the CS-1 to operate.

The CS-1 hardware alone does not send any standard key
commands. It sends special “invisible” ADB commands. Its the
MCS Extension that "re-maps" these commands into useful key
commands. It is imperative that the extension be loaded, and
that the CS-1 is recognized on boot up.

Troubleshooting Possible ADB Conflicts

Certain ADB devices, including track balls, mice, dongles, etc.
may conflict with other ADB devices, preventing them from
operating and sometimes even freezing the computer. These
devices might work find on their own, but as soon as you try to
connect additional ADB devices, they could stop functioning
correctly.

First, disconnect all other ADB devices, except the keyboard,
CS-1, and a standard mouse. Re-boot the computer and try the
CS-1 again. Launch the CS-1 application and select either Test
or About CS-1, this should give you a good indication if the
Macintosh is receiving messages from the CS-1.
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Certain extensions could possibly hinder the operation of the
unit. First disable all suspect extensions or control panels
(older ones are called INITs and CDEVs) using Extensions
Manager (or Startup Manager, or equivalent), and re-start the
computer.

If the problem is corrected, then re-introduce the extensions
back into the Extensions Folder one at a time, restarting each
time, until the problem re-appears and the conflicting file is
discovered.

(Extensions with names like “ADB Basher”, “IceMiceBaby”,
and “Resource Eater” are especially suspect.)

If a mouse click does not appear to work, first try unchecking
"Hide Pointer", so you can see where the click is actually
occurring.

Care and Service

If properly cared for, your CS-1 should provide years of
trouble-free performance. Avoid dropping the CS-1, or hard
banging on the keys.

Clean with a soft cloth dampened with window cleaner.
Do not allow liquids to get inside the unit.

There are no user-serviceable parts in the CS-1. Please refer to

the really fine print following for detailed warranty and service
information.
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JLCooper Electronics Limited Factory Warranty

JLCooper Electronics (“JLCooper”) warrants this product to be free of defects in
materials or workmanship for a period of 12 months from the date of purchase.

This warranty is non-transferable and the benefits apply to the original owner. Proof
of purchase in the form of an itemized sales receipt is required for warranty
coverage.

To receive service under this warranty, customers in the United States should
contact the JLCooper factory and talk to a service technician. If necessary, a Return
Authorization number may be issued.

For our customers outside the United States, it is recommended that you first contact
your Dealer or Distributor, since they may offer their own service or support policy.

If local support is not obtainable, please send a FAX to JLCooper’s Service Depart-
ment at 310-822-2252, with a detailed description of the service required.

Upon issuance of return authorization, the product should be properly packed and
shipped to Service Department, JLCooper Electronics, 12500 Beatrice St., Los
Angeles, CA 90066.

Please include the following: copy of the sales receipt, your name and address (no
P.O. Boxes, please), a brief description of the problem, and any other related items
discussed with the service department and considered necessary to evaluate the
product or effect a repair. The return authorization number must be clearly written
on the outside of the package.

JLCooper will, without charge for parts or labor, either repair or replace the defec-
tive part(s). Shipping costs are not covered by this warranty.

JLCooper’s normal repair turn around time at the factory is approximately 15
business days, from receipt of product to shipping. Your actual turn around time
will include return shipping.

Actual turn around time will vary depending upon many factors including the
repeatability of the customer’s reported complaint, the availability of parts required

for repair, the availability of related products needed to evaluate the product if
necessary.

Priority services are available. These should be discussed with the service technician
at the time the return authorization is issued.

This warranty provides only the benefits specified and does not cover defects or
repairs needed as result of acts beyond the control of JLCooper including but not
limited to: abuse, damage by accident/negligence, modification, alteration, im-
proper use, unauthorized servicing, tampering, or failure to operate in accordance
with the procedures outlined in the owner’s manual; nor for acts of God such as
flooding, lightning, tornadoes, etc.

THE DURATION OF ANY OTHER WARRANTIES, WHETHER IMPLIED OR EXPRESS
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTY OF MERCHANT-
ABILITY, IS LIMITED TO THE DURATION OF THE EXPRESS WARRANTY HEREIN.
JLCOOPER HEREBY EXCLUDES INCIDENTAL AND CONSEQUENTIAL DAMAGES,
INCLUDING BUT NOT LIMITED TO: LOSS OF TIME, INCONVENIENCE, DELAY IN
PERFORMANCE OF THIS WARRANTY, THE LOSS OF USE OF THE PRODUCT OR
COMMERCIAL LOSS, AND FOR BREACH OF ANY EXPRESS OR IMPLIED WAR-
RANTY OF MERCHANTABILITY, APPLICABLE TO THIS PRODUCT. JLCOOPER
SHALL NOT BE LIABLE FOR DAMAGES OR LOSS RESULTING FROM THE NEGLI-
GENT OR INTENTIONAL ACTS OF THE SHIPPER OR HIS CONTRACT AFFILIATES.
THE CUSTOMER SHOULD CONTACT THE SHIPPER FOR PROPER CLAIMS

PROCEDURES IN THE EVENT OF DAMAGE OR LOSS RESULTING FROM SHIP-
MENT.
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